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1. INTRODUCTION

Computer Aided Drafting is a process of preparing a drawing of an object on the screen of a
computer. There are various types of drawings in different fields of engineering and sciences. In the
fields of mechanical or aeronautical engineering, the drawings of machine components and the
layouts of them are prepared. In the field of civil engineering, plans and layouts of the buildings are
prepared. In the field of electrical engineering, the layouts of power distribution system are prepared.
In all fields of engineering use of computer is made for drawing and drafting.

The use of CAD process provides enhanced graphics capabilities which allows any designer to

. Conceptualize his ideas

o Modify the design very easily

. Perform animation
. Make design calculations
. Use colors, fonts and other aesthetic features.

REASONS FOR IMPLEMENTING A CAD SYSTEM

1. Increases the productivity of the designer: CAD improves the productivity of the designer
to visualize the product and its component, parts and reduces the time required in synthesizing,
analyzing and documenting the design

2. Improves the quality of the design: CAD system improves the quality of the design. A CAD
system permits a more detailed engineering analysis and a larger number of design alternatives can
be investigated. The design errors are also reduced because of the greater accuracy provided by the
system

3. Improves communication: It improves the communication in design. The use of a CAD
system provides better engineering drawings, more standardization in the drawing, better
documentation of the design, few drawing errors and legibility.

4. Create data base for manufacturing: In the process of creating the documentation for these
products, much of the required data base to manufacture the products is also created.

5. Improves the efficiency of the design: It improves the efficiency of the design process and

the wastage at the design stage can be reduced.



APPLICATION OF CAD:

There are various processes which can be performed by use of computer in the drafting
process.
1. Automated drafting: This involves the creation of hard copy engineering drawings directly
from CAD data base. Drafting also includes features like automatic dimensioning, generation of
cross — hatched areas, scaling of the drawing and the capability to develop sectional views and
enlarged views in detail. It has ability to perform transformations of images and prepare 3D drawings
like isometric views, perspective views etc.,
2. Geometric modeling: concerned with the computer compatible mathematical description of
the geometry of an object. The mathematical description allows the image of an object to be
displayed and manipulated on a graphics terminal through signals from the CPU of the CAD system.
The software that provides geometric modeling capabilities must be designed for efficient use both
by computer and the human designer.

BENEFITS OF CAD:
The implementation of the CAD system provides variety of benefits to the industries in

design and production as given below:

1. Improved productivity in drafting

2. Shorter preparation time for drawing

3. Reduced man power requirement

4. Customer modifications in drawing are easier

5. More efficient operation in drafting

6. Low wastage in drafting

7. Minimized transcription errors in drawing

8. Improved accuracy of drawing

9. Assistance in preparation of documentation

10. Better designs can be evolved

11. Revisions are possible

12.  Colors can be used to customize the product

13. Production of orthographic projections with dimensions and tolerances
14. Hatching of all sections with different filling patterns
15. Preparation of assembly or sub assembly drawings
16. Preparation of part list



17. Machining and tolerance symbols at the required surfaces
18. Hydraulic and pneumatic circuit diagrams with symbols
19. Printing can be done to any scale

LIMITATIONS OF CAD

1. 32 — bit word computer is necessary because of large amount of computer memory and time
2 The size of the software package is large

3. Skill and judgment are required to prepare the drawing

4

Huge investment

CAD SOFTWARES
The software is an interpreter or translator which allows the user to perform specific type of

application or job related to CAD. The following softwares are available for drafting.

AUTOCAD

CREO 3.0

CATIA V5

ANSYS

NSC NASTRAN
IDEAS

SOLID WORKS
HYPERMESH
FLUENT — GAMBIT

© © N o o B~ w Db E

The above software is used depending upon their application.

AUTO CAD

Auto CAD package is suitable for accurate and perfect drawings of engineering designs. The drawing
of machine parts, isometric views and assembly drawings are possible in AutoCAD. The package is
suitable for 2D and 3D drawings.



STARTING UP AUTOCAD 2016

1. Select the AutoCAD 2016 option on the Program menu or select the AutoCAD2016 icon on

the Desktop. Click Start Drawing to start a new drawing.

, Autodesk
|24 Autodesk Design Review 2013
&,/ Uninstall Tool Computer
| AutoCAD 2016 - English
. Autodesk Q}plication Manager Control Panel

Games

. Autodesk Data Management
| Autodesk Inventor 2016 Devices and Printers

. DWG TrueView 2016 - English
Camnetics Default Programs

| ¥

4 Back Help and Support Start Drawing

| ﬁTemplates v
Tl o

Once the program is loaded into memory, the AutoCAD 2016 main drawing screen will appear on
the screen.

Note that AutoCAD automatically assigns generic names, Drawing X, as new drawings are created. In
our example, AutoCAD opened the graphics window using the default system units and assigned the
drawing name Drawingl.

Autodesk AutoCAD 2016  Drawingl.dwg
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Type a keyword or phrase
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Line Polyline Circle Arc . Text Dimension layers | Block | Properties Utilities | Clipboard | View
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Command :
3%~ Type a command
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2. If necessary, click on the down-arrow in the Quick Access bar and select Show Menu Bar to
display the AutoCAD Menu Bar. The Menu Bar provides access to all AutoCAD commands.
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More Commands...

Show Menu Bar

Show .LQE.I s tha Dibhon
Show Menu Bar

Line Polyline Circle Arc
M Press F1 for more help

3. To switch on the AutoCAD Coordinates Display, use the Customization option at the bottom
right corner.

7 ‘ Coordinf{des ‘

v Model Space

Drawing Units Setup

Every object we construct in a CAD system is measured in units. We should determine the system of
units within the CAD system before creating the first geometric entities.

1. Inthe Menu Bar select:
[Format] [Units]
e The AutoCAD Menu Bar contains multiple pull-down

Format Tools Draw Dimensid

m—— = menus where all of the AutoCAD commands can be

€5 Layer States Manager... z accessed. Note that many of the menu items listed in the

. ;‘"fe”“'s e pull-down menus can also be accessed through the Quick
| i f Access toolbar and/or Ribbon panels.

i Lineweight... ' e Click on the Length Type option to display the
’ :]:n‘y different types of length units available. Confirm the
‘& cale List... . .

s Length Type is set to Decimal.

«% Dimension Style... . .
£ TableStyle.. ‘ Drawing Units

1/8 Multileader Style 1
& Plot Style... Length Angle
I3 PointStyle... Type: Type:

> ultiline e... T
| Muitine 33 [Dedmd v] [Decimal Degrees v]
Units... . L
& mandd | Frnen
D Drawing Limits Engirleering [D i ]
[[I] Rename... Fractional
- Scientific [7] Clockwise
Insertion scale
Units to scale inserted content:
P—— _

3. Angle Type also can be changed by clicking the i”,‘_,ff_
pull down menu of Angle Type. S =

Deg/Min/Sec L¢
Grads
Radians

Decimal Degrees
Surveyor's Units |




4. In the Drawing Units dialog box, set the Length Type to Decimal. This will set the measurement
to the default English units, inches.

Drawing Uni : L L. A
. — 5. Set the Precision to two digits after the decimal
Length Angle . . .
Type: Type: point as shown in the above figure.
[Decimal v] [Dec:imal Degrees v]
Precision: Precision:
0 - 6. Pick OK to exit the Drawing Units dialog box.

[7] Clockwise
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Drawing Area Setup

We will set up the Drawing Limits by entering a command in the command prompt area. Setting
the Drawing Limits controls the extents of the display of the grid. It also serves as a visual reference
that marks the working area. It can also be used to prevent construction outside the grid limits and as
a plot option that defines an area to be plotted/printed. Note that this setting does not limit the region
for geometry construction.

Format Tools Draw Dimension| 1

In the Menu Bar select:

Layer... ; . .
) | Loyer States Manager. [Format] [Drawing Limits]
= Layer tools 4
;er @ Color... fe
L 2. Inthe command prompt area, the message “Reset Model
ineweight... . . .
[N Ll Space Limits: Specify lower left corner or [On/Off]
e j <0.00,0.00>:” is displayed. Press the ENTER key once to accept the
Text Style... -
| e L ; default coordinates <0.00,0.00>.
| & TableStyle... — — — — — —— o e e e
{9 :I::t;:a:ivswle I Reset Model space limits:
ﬁg LIS 7 . [l - LIMITS Specify lower left corner or [ON OFF] <9.00,0.80>:
1 Multiline Style...
N m T . | Model Layoutl Layout2 -+ 59
@ Thickness
D_ Drawing Limits !
7‘[_lj Renar;%.. :7
‘ » I I

3. Inthe command prompt area, the message “Specify upper right corner
<12.00,9.00>:" is displayed. Press the ENTER key again to accept the default coordinates
<12.00,9.00>.

Specify lower left corner or [ON/OFF] <0.00,0.00>:

D- LIMITS Specify upper right corner <12.00,9.00>:
Model ;, layoutl , Llayout2 [ #




4. On your own, move the graphics cursor near the upper-right corner inside the drawing area
and note that the drawing area is unchanged. (The Drawing Limits command is used to set
the drawing area, but the display will not be adjusted until a display command is used.)

5.

6.

7.

ew Insert Format

Tools

/D O
E
Line Polyline Circlg
Draw ‘
Start ‘@
| oo
[~1[Topl[2D Wireframe]| O]
[
! @

Regen
Regen All

Zoom

Pan
SteeringWheels
ShowMotion
Orbit

Camera

Walk and Fly

Clean Screen

Viewports
Named Views...
3D Views

Create Camera

f
b Dimension

Ctrl+0

5557 ol gt Pt Spi Sl B

Realtime

Previous
Window
Dynamic
Scale [
Center

Object

In
Out

All

Exten@

Inside the Menu Bar area select: [View] [Zoom] [All]

The Zoom All command will adjust the display so that all objects in the drawing are
displayed to be as large as possible. If no objects are constructed, the Drawing Limits are
used to adjust the current viewport.
Move the graphics cursor near the upper-right corner inside the drawing area and note
that the display area is updated.

Hit the function key [F7] once to turn off the dis

I-HTopli2D Wireframe]

Y

L

play of the Grid lines.

———" foowine ____JHCE RA 0)

[Command:  <Grid off>

Model | Layoutl | Layout [ +

572,424,000 MODEL i}

b @G-\ LO-RRAN-B-+DPORE

Note that function key [F7] is a quick key, which can be used to quickly toggle on/off the
grid display. Also, note the command prompt area can be positioned to dock below the
drawing area or float inside the drawing area as shown.



Visual Reference

The method we just used to create the freehand sketch is known as the interactive method, where
we use the cursor to specify locations on the screen. This method is perhaps the fastest way to
specify locations on the screen. However, it is rather difficult to try to create a line of a specific
length by watching the displayed coordinates. It would be helpful to know what one inch or one
meter looks like on the screen while we are creating entities. AutoCAD 2016 provides us with
many tools to aid the construction of our designs. For example, the GRID and SNAP MODE
options can be used to get a visual reference as to the size of objects and learn to restrict the
movement of the cursor to a set increment on the screen.

The GRID and SNAP MODE options can be turned ON or OFF through the Status Bar. The Status
Bar area is located at the bottom left of the AutoCAD drawing screen, next to the cursor
coordinates.

Option Buttons
/ p

/

— — — —
—  —

6.21, 3.92, 0.00 MDIgEkiﬁ e b @GNy L D"/k X A

The second button in the Status Bar is the SNAP MODE option and the third button is the GRID
DISPLAY option. Note that the buttons in the Status Bar area serve two functions: (1) the status of
the specific option, and (2) as toggle switches that can be used to turn these special options ON and
OFF. When the corresponding button is highlighted, the specific option is turned ON. Using the
buttons is a quick and easy way to make changes to these drawing aid options. The buttons in the
Status Bar can also be switched on and off in the middle of another command.

| L

Snap mode - Off Display drawing grid - Off
SNAPMODE (F9) GRIDMODE (F7)
00 MODEL i e b BN v 2 Flv £ 4 00 MODEL i v b G v v £ Bl £ A

GRID ON

1. Left-click the GRID button in the Status Bar to turn ON the GRID DISPLAY option. (Notice in
the command prompt area, the message “<Grid on>" is also displayed.)

L

Display drawing grid - Off
GRIDMODE (F7)

—

h.00 MODEL iiii%;r >~ b G~~~ T~ £ 4




2. Move the cursor inside the graphics window, and estimate the distance in between the grid lines
by watching the coordinates displayed at the bottom of the screen.

i

—

0.00, 3.48,0.00 MODEL iiff 0.50, 3.50,0.00 MODEL i

The GRID option creates a pattern of lines that extends over an area on the screen. Using the grid is
similar to placing a sheet of grid paper under a drawing. The grid helps you align objects and
visualize the distance between them. The grid is not displayed in the plotted drawing. The default
grid spacing, which means the distance in between two lines on the screen, is 0.5 inches.

SNAP MODE ON
1. Left-click the SNAP MODE button in the Status Bar to turn ON the SNAP option.

Snap mode - Off
SNAPMODE (F9)

2. Move the cursor inside the graphics window, and move the cursor diagonally on the screen.
Observe the movement of the cursor and watch the coordinates display at the bottom of the
screen.

The SNAP option controls an invisible rectangular grid that restricts cursor movement to specified

intervals. When SNAP mode is on, the screen cursor and all input coordinates are snapped to the

nearest point on the grid. The default snap interval is 0.5 inches and aligned to the grid points on the
screen.

Using the ERASE Command

One of the advantages of using a CAD system is the ability to remove entities without leaving any
marks. We will erase two of the lines using the Erase command.

....... 1. Pick Erase in the Modify toolbar. (The icon

S Mg SO <8 Sk iy S Atodken) is a picture of an eraser at the end of a

?IL». Q A T Em 193 pencil.) The message “Select objects” is

e Erase displayed in the command prompt area and

%c di‘:v Removes objects from a drawing AutoCAD awaits us to select the objects to
'k ERASE erase.

Press F1 for more help

|

2. Select any two lines on the screen; the selected lines are highlighted as shown in the figure
below.
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3. To deselect an object from the selection set, hold down the [SHIFT] key and select the object

again.

4. Right-mouse-click once to accept the selections. The selected two lines are erased.

AL A

Repeat the Last Command

Repeat ERASE

Recent Input

v

Clipboard
Isolate

<R Undo Erase
Redo

L Pan

C%‘ Zoom

@ SteeringWheels

Artinn Barnrdar

1. Inside the graphics window, click once with the right- mouse-
N button to bring up the popup option menu.

*| 2. Pick Repeat Erase, with the left-mouse-button, in the popup
) menu to repeat the last command. Notice the other options
available in the popup menu.

Ctrl+Y AutoCAD 2016 offers many options to accomplish the same
task. Throughout this text, we will emphasize the use of the
AutoCAD Heads-up Design™ interface, which means we focus
on the screen, not on the keyboard.

'

3. Move the cursor to a location that is above and toward the left side of the entities on the screen.
Click Left-mouse once to start a corner of a rubber-band window.

First corner

i/\f

Second corner

11



4. Move the cursor toward the right and below the entities, and then left-mouse-click to enclose all
the entities inside the selection window. Notice all entities that are inside the window are
selected. (Note the enclosed window selection direction is from top left to bottom right.)

5. Inside the graphics window, right-mouse-click once to proceed with erasing the selected
entities.

MODEL #fif i~ L G~~~ T~ £ K
SSSSS——

On your own, create a free-hand sketch of your choice using the Line command.

Experiment with using the different commands we have discussed so far. Reset the status buttons
so that only the GRID DISPLAY option is turned ON as show

I
Polar Snap 1. Inthe Status Bar area, right-mouse-click on SnapMode
T GridSnap — andchoose [Snap settings].
Sr\g Settings... 2. Inthe Drafting Settings dialog box, select the Snap and
oDEL i i "L & - N ~| ©ridtabifitis not the page on top.

GRID Style Setup

3. Change Grid Style to Display dotted grid in 2D model Space as shown in the below
figure.

A Drafting Settings (=34
| Snap and Grid [Polar Tracking | Object Snap | 3D Object Snap | Dynamic Input | Quic| + [ »
[Z] Snap On (F9) [¥]Grid On (F7)
Snap spacing Grid style
v — 050 Display dotted grid in:
% 2D model space
Snap Y spacing: 0.50 [[“Block editor
- X [F] Setsthe grid style to dotted grid for 2D model space. (GRIDSTYLE
|¥| Equal X and Y spacing = system ‘.vgariablé,l g P
Polar spacing Grid X spacing: 0.50
Grid Y spacing: 0.50

4. Pick OK to exit the Drafting Settings dialog box.

12



The GuidePlate

We will next create a mechanical design using the different coordinate entry methods.

S0

Q.

=] 25

25

(PP R

=20

The rule for creating CAD designs and drawings is that they should be created at full size using
real-world units. The CAD database contains all the definitions of the geometric entities and the
design is considered as a virtual, full-sized object. Only when a printer or plotter transfers the
CAD design to paper is the design scaled to fit on a sheet. The tedious task of determining a scale
factor so that the design will fit on a sheet of paper is taken care of by the CAD system. This
allows the designers and CAD operators to concentrate their attention on the more important issues

— the design.

Edit View Insert
Home | Insert Annotate Parametric

- ® /%]

Line | Polyline C|rc|e Arc

’-E

Line
Creates straight line segments |1*
I-1I) ' LINE

Press F1 for more help

1. Select the Line command icon in the Draw toolbar. In
the command prompt area, near the bottom of the
AutoCAD graphics window, the message “ line Specify
first point:” is displayed. AutoCAD expects us to identify
the starting location of a straight line.

2. We will locate the starting point of our design at the
origin of the world coordinate system.

Command: _line Specify first point: 0,0
(Type 0,0 and press the [ENTER] key once.)

3. We will create a horizontal line by entering the absolute coordinates of the second point.
Specify next point or [Undo]: 5.5,0 [ENTER]

4. We will create a horizontal line by entering the absolute coordinates of the second point.
Specify next point or [Undo]: 5.5,0 [ENTER]

5. Move the cursor, which appears as a hand inside the graphics window, near the center of the
drawing window, then push down the left-mouse-button and drag the display toward the right
and top side until we can see the sketched line. (Notice the scroll bars can also be used to adjust

viewing of the display.)

13



6. Press the [Esc] key to exit the Pan-Realtime command. Notice that AutoCAD goes back to
the Line command.

7. We will create a vertical line by using the relative rectangular coordinates entry method,
relative to the last point we specified:
Specify next point or [Close/Undo]: @0,2.5 [ENTER]

Resuming LINE command.
/"~ LINE Specify next point or [Undo]: @e,2.5
Model Layoutl Layout2 +

8. We can mix any of the entry methods in positioning the locations of the endpoints. Move the
cursor to the Status Bar area, and turn ON the SNAP MODE option.

Snap mode - Off
SNAPMODE (F9)

Note that the Line command is resumed as the settings are adjusted.

9. Left-click once on the coordinates display area to switch to a different coordinate display
option. Note the coordinates display area has changed to show the length of the new line and its
angle. Each click will change the display format of the cursor coordinates.

Drawing Coordinates
rds COORDS (Ctrl + 1) rds on» <Coords off: <Coords on:

8.16, lﬁ 0.00 MODEL i 542-:313_& MODEL i

10. On your own, left-click on the coordinates display area to observe the switching of the
coordinate display; set the display back to using the world coordinate system.

11. Create the next line by picking the location, world coordinates (8,2.5), on the screen.

rds on®* <Coords off> <Coords on®
—_— T —

~ ~N
( 8.00,2.50, 0.00 JMODEL i}
~ -—
#

14
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12. We will next use the relative polar coordinates entry method, relative to the last point we
specified:

Specify next point or [Close/Undo]: @3<90 [ENTER]

(Distance is 3 inches with an angle of 90 degrees.)
13. Using the relative rectangular

coordinates entry method to create the

o next line, we can imagine a reference
= coordinate system aligned at the
o previous point. Coordinates are
measured along the two reference
axes.

Reference Coordinate System |
aligned at the previous point

o Specify next point or [Close/Undo]:

o @-1.5,1 [ENTER]

I (-1.5 and 1 inches are measured relative
by o to the reference point.)

14. Move the cursor directly to the left of the last point and use the direct distance entry
technique by entering 6.5 [ENTER].

Specify next point or [Close/Undo]: @-1.5,1
/v LINE Specify next point or [Close Undo]: 6.5
Model | Layoutl Layout? *

Enter 15. For the last segment of the sketch, we can use the Close

Cancel option to connect back to the starting point. Inside the

Recent Input , graphics window, right-mouse-click and a popup menu
appears on the screen.

Close

. L\@ 16. Select Close with the left-mouse-button to connect back to

the starting point and end the Line command.

15
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Creating Circles

The menus and toolbars in AutoCAD 2016 are designed to allow the CAD operator to quickly
activate the desired commands.

1.

2.

_ _ _ ODedBSR-=-+
In the Draw toolbar, click on the little triangle — , e <e
below the circle icon. Note that the little triangle Home (RESCE Dt I e
indicates additional options are available. Paell .| Vo g g
Line Polyline Cu;clj Arc Y
Draw -

In the option list, select: [Center, Diameter]

T R SR

' File Edit View Insert Format Tools Draw Dimension
Home Insert Annotate Parametric View Manage Output Add-ins

S o =20t 4 A W "
@S- | %G M - &
Line Polyline| Circle Arc ?" Alh £ £ Text Dimension a
A B -|[(A B0 88 & N A
Meodify ~ Annotation ¥
@ Center, Radius odity SEIREN
Start +
1-1Topli2D Wir ‘@ Center Dimees
. Q 2-Point | Center, Diameter .
~s Creates a circle using a center point and a diameter
% QB—Point :
‘mm CIRCLE
. @ Fan, Tan) Press F1 for more help
. OTan,Tan,Tan

Notice the different options available under the circle submenu:

« Center, Radius: Draws a circle based on a center point and a radius.

« Center, Diameter: Draws a circle based on a center point and a diameter.
« 2 Points: Draws a circle based on two endpoints of the diameter.

- 3 Points: Draws a circle based on three points on the circumference.

< TTR-Tangent, Tangent, Radius: Draws a circle with a specified radius
tangent to two objects.

< TTT-Tangent, Tangent, Tangent: Draws a circle tangent to three objects.

In the command prompt area, the message “Specify center point for circle or [3P/2P/Ttr (tan
tan radius)]:” is displayed. AutoCAD expects us to identify the location of a point or enter
an option. We can use any of the four coordinate entry methods to identify the desired
location. We will enter the world coordinates (2.5,3) as the center point for the first circle.

16



Specify center point for circle or [3P/2P/Ttr (tan tan radius)]: 2.5,3 [ENTER]

Command: _circle

(¥)~ CIRCLE Specify center point for circle or [3P 2P Ttr (tan tan radius)]: 2.5,3|
Model | Layoutl | Layout2 [ # 10.50,4.50,0.00 MODEL if

4. Inthe command prompt area, the message “Specify diameter of circle:” is displayed.
Specify diameter of circle: 2.5 [ENTER]

N

A R

| o
» o
| |
WX |
Repest CHE 5. Inside the graphics window, right-mouse-click to bring up
SEEERAES ’ the popup option menu.
Clipboard : , :
o "| 6. Pick Repeat CIRCLE with the left-mouse- button in the
Isolate > popup menu to repeat the last command.
| U”d° tclpan | 7. Using the relative rectangular coordinates entry method,
i e relative to the center-point coordinates of the first circle,
| pan we specify the location as (2.5,2).
G?l Zoom
(O] SteerinaWheels

Specify center point for circle or [3P/2P/Ttr (tan tan radius)]: @2.5,2 [ENTER]

8. In the command prompt area, the message “Specify Radius of circle: <2.50>" is displayed.
The default option for the Circle command in AutoCAD is to specify the radius and the
last radius used is also displayed in brackets.

Enter 9. Inside the graphics window, right-mouse-click to bring up the
Cancel popup option menu and select Diameter as shown.
Recent Input »

10. In the command prompt area, enter 1.5 as the diameter.
Diameterh
Snav Overrides »

17
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Specify Diameter of circle<2.50>: 1.5 [ENTER]

@

Saving the CAD Design
P = S =

[3
Save (Ctrl+S) i
0 Sa

= Fxport >

1. Inthe Application Menu, select:

[Application] [Save]

Note the command can also be activated with the quick-
key combination of [CtrI]+[S].

In the Save Drawing As dialog box, select the folder in which you want to store the

2.
CAD file and enter GuidePlate in the File name box.
& Save Drawing As @
Savein: [ | Projects v] & E_‘_.,, @ b4 ET'._ Views ~ Tools
p— Mame - Daty  Preview
@ Bracket.dwg 32
L =
<
;;I Thumbnails
- [] Update sheet and view
thumbnails now
b
@Q
-
4 nr 3
File name:  GuidePlate =
Files of type: | AutoCAD 2013 Drawing (.dwa) v] 9 oae
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3. Click Save in the Save Drawing As dialog box to accept the selections and save the file. Note

the default file type is DWG, which is the standard AutoCAD drawing format.

Close the Current Drawing

Several options are available to close the current drawing:

I DEEB8 G-« =L Select [Close] [Current Drawing] in the

Search Commands

@J@J Close the drawing

D New 4 Current Drawing
Clo's\e the current drawing.

f_l All Drawings
D Close all currently open drawings.

Application Menu Bar as shown.

Enter Close at the command prompt.

Command: _QSave

>_|~ CLOSE

Model = Layoutl

Layout2

*

The third option is to click on the [Close] icon located at the
upper-right-hand corner of the drawing window.

19



Drawing Units Setup

Every object we construct in a CAD system is measured in units. We should determine the
system of units within the CAD system before creating the first geometric entities.

I -

EREEERES

Format Tools

=
=

©

QAR &

Layer...

Layer States Manager...

Layer tools
Color...
Linetype...
Lineweight...
Transparency
Scale List...

Text Style...

Draw

Dimension Style...

Table Style...
Multileader Style
Plot Style...
Point Style...
Multiline Style...

Units...
Thickness

Drawing Limits

Rename...

Dimensi

- 1. Inthe Menu Bar select:
[Format] [Units]

Q.

=]

E « The AutoCAD Menu Bar contains multiple pull-down
menus where all of the AutoCAD commands can be
accessed. Note that many of the menu items listed in the
pull-down menus can also be accessed through the Quick
Access toolbar and/or Ribbon panels.

2. Click on the Length Type option to display the different types of length units available.
Confirm the Length Type is set to Decimal.

4.

Angle
Type:

3. On your own, examine the other settings that are

Decimal Degrees
Decimal Degre
Deg/Min/Sec h‘
Grads

Radians
Surveyor's Units

- available.

In the Drawing Units dialog box, set the Length Type to Decimal. This will set the
measurement to the default English units, inches.

5. Set the Precision to two digits after the decimal point as shown in the above figure.

6. Pick OK to exit the Drawing Units dialog box.
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& Drawing Units @

Length Angle
Type: Type:

[ Decimal - l [Decimal Dearees v]

Precision: Precision:
T d 5

0
0.0 [ Clockwise

0.000 g

0.0000
0.00000
0.000000
0.0000000
0.00000000
Sample Ompat

4 rnnnoa onnanon nnnn

Drawing Area Setup

We can set up the Drawing Limits by entering a command in the command prompt area. Setting
the Drawing Limits controls the extents of the display of the grid. It also serves as a visual
reference that marks the working area. It can also be used to prevent construction outside the grid
limits and as a plot option that defines an area to be plotted/printed. Note that this setting does not
limit the region for geometry construction.

Format Tools Draw

Layer... P
® wesmeeee- F 1. Inthe Menu Bar select:
ayer tools d . - -
@ Color.. | [Format] [Drawing Limits]
Linetype...
N Lineweight...
. E 2. Inthe command prompt area, the message “Reset Model
| ooals L me Space Limits: Specify lower left corner or [On/Off]
& e <0.00,0.00>:" is displayed. Press the ENTER key once to accept
£ TableStyle.. the default coordinates <0.00,0.00>.
/S Multileader Style
> Plot Style...
157 Point Style...
" Multiline Style... Command: '_limits
= Reset Model space limits:
&P Thickness D~ LIMITS Specify lower left corner or [ON OFF] <©.0000,0.0000>:
| Drawing “"&“ Model | Llayoutl | Layout2 [ # 7.2181 7.0502
1] Rename...

3. Inthe command prompt area, the message “Specify upper right corner
<12.00,9.00>:" is displayed. Press the ENTER key again to accept the default coordinates
<12.00,9.00>.

Reset Model space limits:
Specify lower left corner or [ON/OFF] <0.0000,0.0000>:

D' LIMITS Specify upper right corner <12.0000,9.0000>:

Model Laj.”OUtl Lay’cutZ * 0_0012‘ 3.9069,
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4. On your own, move the graphics cursor near the upper-right corner inside the drawing area
and note that the drawing area is unchanged. (The Drawing Limits command is used to set

the drawing area, but the display will not be adjusted until a display command is used.)

Edit View = Inset Format  Tools

Draw  Dimension  Modify

5. Inside the Menu Bar area select:
[View] [Zoom] [All]

;HAome tm Aﬂ]/ Redraw Add-ins  Autods
7 Regen =~ g. Q A )
/;y‘? c@|‘f° Regen Al b - m 5 The Zoom All command will adjust the
" Zoom '@ Reatfme |5 display so that all objects in the drawing
e - Zf"_gWh | 4y Previous are displayed to be as large as possible. If
New Tab [ eeringWheels - . .
o0 widramey . Shoeton 4 :YW no objects are constructed, the Drawing
' Orbit E s Limits are used to adjust the current
Camera * [ e .
Walk and Fly » E—,z gbj:ct VIeWpOrt
clansaer “ o ‘| 6. Move the graphics cursor near the upper-
Sl el | right corner inside the drawing area, and
30 Views , E:Z 0 note that the display area is updated.
(C)] Create Camera T

MODEL i} :

y ‘ Polar Snap

v Grid Snap

Snap Settings...

7. In the Status Bar area, right-mouse-click on
SnapMode and choose [Snhap Settings].

8. In the Drafting Settings dialog box, switch on the Snap
and Grid options as shown.

'IJ_G'\J[\'_

A Drafting Settings

=X

Snap and Grid |F‘olar Tracking IObject Snap |3D Object Snap I Cynamic Input I Quic| * | *

Snap On (F3)
Snap spacing

Snap X spacing: 0.50
Snap Y spacing: 0.50

Equal X and ¥ spacing

Palar spacing

Grid On {F7)
Grid style
Display dotted grid in:
20 model space

[ Block editor

[[] SheetAayout
Grid spacing

Grid X spacing: 0.50

Grid Y spacing: 0.50

Maijor line every: 5 =

On your own, exit the Drafting Setti
GRID DISPLAY and SNAP MODE are turned ON as shown.

ngs dialog box and reset the status buttons so that only

MODEL i i -

E_@"\{\'LD' OJ
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Using the ERASE Command

The vertical line on the right was created as a construction line to aid the construction of the
rest of the lines for the design. We will use the Erase command to remove it.

ormat ools Uraw Uimension Mod

5 S [ e | 2 1. Pick Erase in the Modify toolbar. The

o O - : A ﬁ g = message “Select objects” is displayed in

s & - @ the command prompt area and

E N LR I—— . AutoCAD awaits us to select the

lemoves objects from a drawing

Modify v | objects to erase.
= ERASE

Erase

+
Press F1 for more help

2. Select the vertical line as shown.

3. Click once with the right-mouse-button
to accept the selection and delete the
line.

Using the Arc Command

MRS SRS 1. Click the down-arrow icon of the Arc command in the Draw

notate  Parametric  View  Manage . . . .
= # 0+ 2 toolbar to display the different Arc construction options.

;|®. % M ]- &

T n- BB e

AutoCAD provides eleven different ways to create arcs. Note

T - that the different options are used based on the geometry
|/ s comenna [+~ conditions of the design. The more commonly used options are
I R the 3-Points option and the Center-Start-End option.
| smematasn| | 5 Select the Center-Start-End option as shown. This option
| (7 s g angie | © requires the selection of the center point, start point and end
1/ san, e, Divection |+ - - point location, in that order, of the arc.

:/IStart, End, Radius
‘[‘: Center,!gtart, End ‘

] / Center, | T
| + Center, Start, End

) Cenii Creates an arc using a ce
o e ‘ that determines the endp|

.ﬁ(cntan = ARC
I

Press F1 for more help
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3.

+

Move the cursor to the middle of the two
horizontal lines and align the cursor to the two
endpoints as shown. Click once with the right-
mouse-button to select the location as the
center point of the new arc.

4. Move the cursor downward and select
the right endpoint of the bottom
horizontal line as the start point of the
arc.

5. Move the cursor to the right endpoint of the
top horizontal line as shown. Pick this
point as the endpoint of the new arc.

6. On your own, repeat the above steps and
create the other arc as shown. Note that in
most CAD packages, positive angles are
defined as going counterclockwise;
therefore, the starting point of the second
arc should be at the endpoint on top.
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Review Questions:

1. What are the advantages and disadvantages of using CAD systems to create engineering
drawings?

2. What is the default AutoCAD filename extension?
3. How do the GRID and SNAP options assist us in sketching?
4. List and describe the different coordinate entry methods available in AutoCAD.

5. When using the Line command, which option allows us to quickly create a line- segment
connecting back to the starting point?

6. List and describe the two types of coordinate systems commonly used for planar geometry.
7. Which key do you use to quickly cancel a command?

8. When you use the Pan command, do the coordinates of objects get changed?
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1. Angle Spacer

3.2 - D Figures Using ACAD

(All dimensions are in inches.)

1.25 -
J, |-.—,75—.- ' 1.0
25 |
=
1.0
| 2.0
2. Channel Plate
125
-—0.254‘ \
= ase n.*eu 45
i At
0125 /
T
185 075 |=—o020 —= 050
S0 |
4
01es \ .
0Es t e 4
¥ ] sz n.fo e
-—0.25*‘ }
125
150
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Isometric Drawings Using ACAD 2016

For all isometric figures right click GRID in drafting tool bar <setting> change grid snap to
ISOMETRIC SNAP. And check ORTHO ON

F5 - TOGGLE KEY BETWEEN ISOPLANE TOP, ISOPLANE LEFT AND ISOPLANE
RIGHT

FIGURE 1

Aim: to draw the following figure using ACAD
COMMANDS USED

Line, Dimensions, Drafting commands
PROCEDURE

<Ortho on> <Isoplane Top> <Osnap on>
Command: _line Specify first point:
Specify next point or [Undo]: 104

Specify next point or [Undo]:

Command: _gsave

Command: _dimaligned

Specify first extension line origin or <select
object>:

Specify second extension line origin:
Command: _dimlinear

Specify first extension line origin or <select

object>:

Specify second extension line origin:

Specify dimension line location or [Mtext/Text/Angle/Horizontal/Vertical/Rotated]:
Dimension text = 48.0000

Command: _dimedit

Enter type of dimension editing [Home/New/Rotate/Oblique] <Home>: o

Select objects: 1 found

Enter obliquing angle (press ENTER for none): 30

Command: _gsave
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INTRODUCTION TO CREO 3.0

CreoParametric 3.0 Interface

= — T View Options
CIEE="] c T 0l+ PRT0001 (Active) - PTC Creo Parametric Student Edition (for educational
File v Model Analysis Annotate Render Tools View Flexible Modeling Applications
jt‘ '} User-Defined Feature 7 Axis A 4 o Revolve & Project 7y A ri
J Copy Geometry % Point ¥ Sl i Sweep ¥ c { ] Style
Regenerate Plane ” Sketch  Extrude Boundary Component
v ) A Coordinate System & Swept Blend Blend [(J)Freestyle Interface
Operations ¥ Datum v apes v Engineering v Editing v Surfaces v Model intent v
B [& [ q & Q|4 0, @ % 3|
Model Tree
(1)) PRT0001.PRT IConS
L7 RIGHT H
; Ribbon Menu
L7 ToP
L7 FRONT
T e R .. .
aA* PRI_CSYS DEF Origin (Axis Center x-0, y-0, z-0)
% Insert Here
Feature Manager
Ly
View port
§u L,vi * Using the template default SPRO_DIRECTORY\templates\inibs_part_solid.prt as the template. ® n Smart

Mouse Buttons

Left Button - Most commonly used for selecting objects on the screen or sketching.

Right Button — Used for activating pop-up menu items, typically used when editing. (Note: you must hold the down
button for 2 seconds)

Center Button — (option) Used for model rotation, dimensioning, zoom when holding Ctrl key, and pan when holding

Shift key. It also cancels commands and line chains.

Center Scroll Wheel — (option) same as Center Button when depressed, only it activates Zoom feature when scrolling
wheel



Options & Properties, menus, the heart of Creo

Selecting the File—Options --pull down- (located at the top left side of the screen) opens the active documents

Options.

@B R0

Sheetmetal

Licensing

Manage File »
Prepare >
Send »

Manage Session »

Help

Opti

Eq =

Customize Ribbon
Quick Access Toolbar
Window Settings

Configuration Editor

Creo Parametric Options

File » Model = Analysis  Annotate Favorkes I | change how entties are displayed.
= System Colors ‘ Geometry display settings
New Recent Files Model Display Default geometry display: Shade With Edges v
X Entity
~ Open Last Session Selection Edge quality display: Very High -
@ Open Sketcher Tangent edges display style: = Solid v
Assembly

Data Exchange Anti-Aliasing 18X -

@' Show colors assigned to model surface
[[] show smooth lines
Datum display settings.
[ Show datum planes
[ Show datum plane tags
[ show datum axes
[T] Show datum axis tags
[ Show datum points
Show point symbol as:  Cross -
[[] show datum point tags
[g Show datum coordinate system
E Show coordinate system tags
[ Show images

notes and
[C] Show dimension tolerances

display seftings

[[] Show note names instead of note text

D Show reference designators of cabling, ECAD and piping components
[ Show annotations and Annotation Elements

[Z Show annotation orientation grid

Set grid spacing to: | 0.100

Assembly display settings

Model Properties

BOgho-o-B@ i~

File ~ Model  Analysis _Annotate  Render  Tools View  Fle

D New Prepare model for distribution
.
Open Model Properties
| Edit model properties.
7

Mod3(CHECK Intet ' Model Properties
Edit model properties.

& model in
r crawir

Check information report.

ModelCHECK Rule Check
Display rules associated with this model.

ManageFile | §/0/ ModelCHECK Geometry Check
rw Check modiel geometry for VDA standard.

DRM Session Report
5 Generate a DRM session report.
Send »
Apply DRM Policy
Manage Session Define how to apply a DRM policy.

Help » L Remove DRM Policies
Define how to remove a DRM Policy .

Policy Se
']

Model Properties

2 materials

Material Net assigned

Units Inch lbm Second (Creo Parametric Defeult)

Accuracy Relative 0.0012

Mass Properties (7]

(%4 Retations, Parameters and Instances

Relations Not defined (7]
Parameters 2 defined Q
Instance Not defined Active: Generic - E8

47 Features and Geometry

Tolerance st

Names 7 defined

i Tools

Flexible Not definedt

Shrinkage Not defined Q
Simplfied Representation 4 defined Active: Master Rep (7]
ProfProgram Q
Interchange Not defined

[ Modet Interfaces
Reference Cortrol Defauit settings
Detail Options

Detal Options

change

x
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View options

Zoom In

Sketching

Start Sketch

Zoom Out

Rectangle

Arcs
3 Point
Tangent

i Standard Orientatio

Repaint
_\ , :
Shaded

1
v

Default Orentation
BACK

BOTTOM

FROMNT

LEFT

RIGHT

TGP

l mn 3

Datum Plane

Spline
1

Objects

I RE
I -

Spin Center

@ % & o

Create Cross-sections
I | foradrawing

y /

[ view Managy

Simp Rep |x=sec | Orient | Al |

==

[New” Edi‘t*“

Display = J

Names

Symbolic Rep
Geometry Rep
Graphics Rep

Properties »>

Close

Fillet

Concentric

Point

Constraint/
Relations

Trim

Apply/Finish

Convert
Entities &
Offset

TARINTRENIR QI N

Mirror

k

Cancel

NOTE: If you do not see all of these icons on your interface you can customize the toolbars to bring them up.
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Where do you start a sketch?

Sketches can be created on any Datum Plane or Planar Face or Surface. Pro/E provides you with
three datum planes centralized at the Origin (your zero mark in space)

NOTE: Planes can also be created and will be discussed in more detail in the future. Also after
completing a sketch always select the Apply/Finish check mark on the sketch toolbar, this will
activate the extrude or revolve feature tools.

B OSEgo-~-88® -0+ E1 (Active) - Creo Parametric Student Edition = %
a v
File v Model Analysis Annotate Render Tools View Flexible Modeling Applications p e 0
1 £y @ User-Defined Feature £ Axis s Revolve » % Project > O
1 7 mogl il i
d b Copy G x v » < W v 5 N
- Copy Geometry x % Point weep 5]
Regenerate o Plane Sketch  Extrude Pattern Boundary Component
v * (3% Shrinkwrap %¥x Coordinate System & Swept Blend v - Blend Interface
Operations ~ Get Data ~ Datum ¥ Shapes ¥ Editing ¥ Surfaces ¥ | ModelIntent ¥

=
Model Tree Ww-8-
{J E1.PRT
7 RIGHT
7 TOP
{ 7 FRONT

3« PRT_CSYS_DEF
& Insert Here %

| @ L] 1Hi Smart v
To start a sketch Pre-select the plane or face you desire to sketch on and then select the Sketch Icon.

Sketch Options

7 Sketch 3]
Placement | Properties |

Sketch Plane

Plane FROMNT:F3DA. | == Previous

(i}

Sketch Orentation

Sketch view direction

Reference  RIGHT:F1({DATUM PLANE)

—

( [ Ske‘tch\u Cancel |

~ o —
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Controlling your geometry

Pro/E uses two methods for constraining geometric entities.

Constraints and Dimensions:

Constraints can be referred to as common elements of geometry such as Tangency, Parallelism, and
Concentricity. These elements can be added to geometric entities automatically or manually during

the design process.

Here is an example of
adding arelationship
between two geometric

entities.
_—
L S - e _:at:ﬁvs_\ Sketch
L (o ¥
: Oz
P *e |H| =
. Normal .
Lo/ "

Constrain ¥ Dimension ¥

Cautious sketching can save time

There are 3 primary file types in Creo, which iYclude...

1. Part (.prt) Single part or volume.
2. Assembly (.asm) Multiple parts in one file assembled.
3. Drawing (.drw) The 2D layout containing views, dimensions, and annotations.
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Switching between documents (Activating a document)

- I‘ "1
File » Model Analysis
& | R
—t
File Selec
Lag
"r}_?] System v
Setup ¥ GetData Operations ¥

Datum

Select the Window pull-down menu and you will see the available documents. Click on the
document you wish to work on from the list to update it.

Sketch Constraints (Relations)

cations Sketch
'
Boose e &
Normal
L o/ e
Constrain ¥ Dimension ¥
Constraint Geometric entities to select Resulting Constraint
Horizontal One or more lines or two or more 'The lines become horizontal or vertical (as defined by
or Vertical points. the current sketch space). Points are aligned horizontally
or vertically.
Collinear 'Two or more lines. The items lie on the same infinite line.
Perpendicular Two lines. 'The two items are perpendicular to each other.
Parallel Two or more lines. The items are parallel to each other. The line is
/A line and a plane (or a planar face)
in a 3D sketch. parallel to the selected plane.
Tangent /An arc, ellipse, or spline, and a line or [The two items remain tangent.
arc.
Concentric 'Two or more arcs, or a point and an  |The arcs share the same centerpoint.
Midpoint 'Two lines or a point and a line. 'The point remains at the midpoint of the line.
Coincident /A point and a line, arc, or ellipse. 'The point lies on the line, arc, or ellipse.
Equal 'Two or more lines or two or more 'The line lengths or radii remain equal.
arcs
Symmetric /A centerline and two points, lines, The items remain equidistant from the centerline,
arcs, or ellipses. on a line perpendicular to the centerline.

36



Controlling your geometry with dimensions...

5000

[e——3.000 ———=

1.750

3.500

e— 1.500

Dimensioning this way will
enable the length of the
bracket to change but the
holes will always remain
positioned to the left side.

Sketf_h
N LA OO
L e (L

\ Normal "—
Lo/ \_/%
Constrain ¥ Dimension ¥

.ations

Strong versus Weak
Dimensions -
Double click and

change to make
them Strong!

Dimensioning this way will
enable the length of the
bracket to change but the
holes will always remain
positioned to 1.5” off each

3.500

1.750

‘—1.500*1

te— 1,500 —=
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Solid Modeling Basics

1. Layer Cake method
(57
Extruded Boss/Base (Creates/Adds material)
(7 |
Extruded Cut (Removes material)
Ingredients:
' Profile

2.

Revolve method

Revolve Boss/Base (Creates/Adds material)

Revolve Cut (Removes material)

1000 |=—

— 1000 f—

1.250

1.000 =

780 -
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EXERCISE 1

Introduction to basic part modeling

Base Extrude Features create a 3D solid representation by extruding a 2 dimensional profile of the

~
o

entity.

Objective:
Create a
solid

=] ===

O] This will create a hole.

? L L

This will fail to extrude.

file
’ 4. Select the

. ” Rectangle tool.

] = By . e B X
Filev=" Model  Analysis Annotate  Render Tools  View Modeling  Applications | | Sketch Le-0

- Y H i Lo S 4 o = JEy

Q’ B k i i @ 2 [ = i}f Y v X

8 % b3 V- +N= = b

" File Select Palette ) Normal Feature - Ol Cancel

@2 system - Y Lo/ 12 Requirements |8

Edting  Constrain ¥ Dimension ¥ Inspect ¥ d

Setup ¥ GetData Operations ¥ Datum
& m Q& QHEOD B %S % E
Model Tree w-a-
| ELPRT 3. Select the
{7 RIGHT

i Sketch icon.

£7 FRONT
2« PRT_CSYS_DEF

7. Click to finish
sketch.

6. Double Click

§n @  © Whena constraint is active, right click to cycle through lock/disable/enable the constraint. Use Tab key {

2. Select the to edit the
OFOoYtO . dimensions.
@ngtn
Seare Fere
5. C|ICk and drag ) 1selected Al v

across.
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Operations ¥

%4« Coordinate System

Sketch

oratt » (1] DI Mirror 4] Extend

= Project

A 8 [
[/3 Culn;enl
&> Swept BER 7 SeleCt BOSS )  Interface
GetData ~ Datum v Shapes ~ EXtrude_ ks~ Model intent ¥
§c % E] @ ;!\\ ...iq
Model Tree W - E[ [
(J E1PRT
£7 RIGHT
£ ToP (=
£7 FRONT | —_—
A PRT_CSYS_DEF | g
74 Sketch 1 \ |
# InsertHere \ |
| |
\ \
| . |
| ! \
| i |
| \
\ |
\ |
\ \
| \
\ \
\‘ “
L \
~ |
O
~
Ba| @ Coordinate Systems wil not be displayed @ [H) | 1selected Smart v
NOTE: When dimensioning use the dimension tool and make edge selections, mouse center button click to apply dimension.
DB v E1 (Active) - Creo Parametric Student Edition s B X
File » Model Analysis Annotate Render Tools View Flexible Modeling Applications Extrude D e M 0
. ns
OQ -7 WX 4 C IIOIﬂmOJ‘:f:}X Datum
eyfoen [rtons | Properies :“‘M’"% sl
§c % ] Q&A@ T 9 Hlt “Appl}’”
s MR the green check
o RicHT mark to finish.
£7T0P
£7 FRONT
4« PRT_CSYS_DEF
73 Sketch 1
& Insert Here

» o7 ¥Extrude 1

@ .5”.

8. Set to Blind

[8o] /@ selecta sketch. (f an internal sketch is preferred, the "Edt” option can be found in the Placement panel )

L)

1 selected Sketch

D@~ @~09 E1 (Active) - Creo Parametric Student Edition o B X
Analysis Annotate Render Tools View Flexible Modeling Applications L D e ¥ o
@ User-Defined Feature 7 Axis n 7] sk Revolve
o & 14" Copy Geometry «x Point ¥ . =/
Regenerate Plane
- ¢ v [E§ Shrinkwrap
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W O0es@o-c-2F-03 v E1 (Active) - Creo Parametric Student Edition
File v Model Analysis Annotate Render Tools View Flexible Modeling Applications
I3 By @ UserDefned Feature 7 axs e A s Revolve 0¥ Hole D Dratt v " + Extend 2% Pro)
o~ %, ~ [t Copy Geometry % Point o {sweep ¥  PRound v (@) Shel Trm 7] Offset
Regenerate e Sketch  Extrude Patiern
v ¥ * [ Shrinkwrap % Coordinate System &P SweptBlend <) Chamfer ¥ =/ Rib ~ = = Nl ntersect
Operations ~ GetData ~ Datum ¥ Shapes ~ Engineering ¥ Edting ¥
+am P IEEA E E
Model Tree W-8-
[ E1PRT
£7 RIGHT
£7TOoP i
e Toggle views
%<PRT_CSYS_DEF using
5 2P e the OView
& InsertHere Orientation
10. To sketch the =

next feature select the
front face of the
model and then select
the

O“ketbh iDoY.

Default Qrientation
BACK

BOTTOM
FRONT

LEFT

RIGHT

TOP

4 laama] v

-y

Adding a constraint — Ctrl Select both left edges of sketch and solid. Select Coincident

File v Model  Analysis = Annotate Render Tools View Flexible Modeling  Applications Sketch
g & p wrOh i g BE L eNE g B oy
a : % B8 % W= + N = O
- File Select Construction - Palette —_— Normal &5 Feature OK Cancel
@@ system - b Mode G-~ B O& L | 2 Requirements I
Setup ¥ GetData Operations ¥ Datum Sketching Edting ~ Constrain ¥ ion ¥ Inspect ¥ Close
@ w Ty ey
o B & Q& HEd B %R
8
Model Tree L RAER
£ E1PRT
£7 RIGHT
£7T0P
£7 FRONT

2 PRT_CSYS_DEF

o Extrude 1
& Insert Here

L © /]

Constrain ¥

Extrude
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R LA

File » Model Analysis Annotate Render Tools View Flexible Modeling

Ola s _+x 4 C

Placement | Option

P B®
Model Tree W~ E

I E1PRT
£7 RIGHT
[77T0P

iyl Enter height

%« PRT_CSYS_DEF

» o Extrude 1
7 Sketch 2
& InsertHere

» o ¥Extrude 2

I ©/1%[f 60 v X

E1 (Active) - Creo Parametric Student Edition

Applications Extrude

AR O, B % E

1. Select the

’

I.'j’_"l

Extrude icon.

W | 1selected

Select the face, select sketch icon and draw a circle on the face. Dimension, Hit [JOk[]

BO0@@o 2B~

File » Mode! Analysis Annotate Render Tools View Flexible Modeling

& %[ |
o é 2 k O-Q-y¥y-ex

Select Construction Palette
v

&3 system @ b Mode o, A OA
Setup ¥ GetData Operations ¥ Datum tching

9
B®

Model Tree w8~
[ E1PRT

£7 RIGHT

7 ToP

£7 FRONT

%« PRT_CSYS_DEF

» 7 Extrude 1

» o Extrude 2
% Insert Here
#% #Sketch 3

AN e L

E1 (Active) - Creo Parametric Student Edition

Applications Sketch

sk ¥ g = (=
2 Normal Feature -  OKwggancel
9 Lo/ el Requirements %

Edting = Constrain ¥ | Dimension ¥ Inspect ¥ Close

Q&aano B ke T

Select the face, select sketch icon and draw a circle on the face. Dimension, Hit Ok
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E1 (Active) - Creo Parametric Student Edition

T2k

Annotate  Render Tools  View

BO0g@o -

File » Model  Analysis

o

Bm

Model Tree

[J E1PRT
£7 RIGHT

7 ToP

£7 FRONT

% PRT_CSYS_DEF

-8

» & Extrude 1

» & Extrude 2
% Insert Here
7% ¥Skelch 3

Flexible Modeling Applications
A ) T Y e &

g X H g w974
é 2 k x e H+Q-F«8 x Palette IR B o8 = Nnmmi:E
h O 9 Lo/

o 2
e File -, | Select Construction 3
&2 sysem B v 5 Mode vy, ) A 5

Setup v GetData | Operations ¥ Datum tching Edting = Constrain v Dimension ¥ spect ¥

+ (=) xe o
Q&AEO @@ %S S E

Sketch

=y

Feature —— OK
el Requirements | %

ancel

Close

Go to file save

BOSEo o g ® ol

File v Model Analysis Annotate Render
26 8 @ User-Defined Feature 7 7 Ads P % sfo Revolve
97 &« B Copy Geometry 3% Point ¥ SR = € sweep

Regenerate e Sketch  Extrude

% ~ (B Shrinkwrap 2% Coordinate System

GetData ¥ Datum ¥ Shapes ¥

Update or Regenerate model
changes using the
ORegenerated button.
Although it is unnecessary in
this instance it is still a very
important tool. It will update
only dimensional or feature
changes made to the model.

+

B4

| m

Tools View Flexible Modeling Applications

&2 SweptBlend ) Chamfer v &/ Rib ~

E1 (Active) - Creo Parametric Student Edition

AT Hole 2 Dratt v |

v P Round ¥ Shell
Pattern

Engineering ¥

= B R

~00"0
Y Extend 2 Project @ (=] E ]
haen: puiiasy Component

Blend ) Interface
Surfaces ¥ Model intent ~

Q& E DB %
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EXERCISE 2

Revolved Features

Revolved Feature - creates features that add or remove material by revolving one or
more profiles around a centerline. The feature can be a solid, a thin feature, or a

surface.

Tips...

Profile ':::"i'%

I
I
Centerline, Edge, or i
Axis of Revolution !

The profile should never cross over the centerline, nor should there be profiles on
both sides of the centerline.
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Create a new pat file .

1.

1.

Using the dimension tool to create a ¥4 of the geometry and then sweep it to the other side.
Make sure you finish adding the dimensions.

Select the Revolve feature icon.

S

Then select the axis/centerline.
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| File Edit View Inset Analysis Info Applications Tools Window Help

DEEegYvoey baRitn-EREgRa@srsBed ON

EN
Oad 1w =0 -%xX 4 C
Placement Options  Properties

L EEES

Show ¥ || Settings ¥

(7] PRT0006.PRT
47 RIGHT
{7 TOP
47 FRONT
- (< PRT_CSVS_DEF
7% Sketch1
o Insert Here
sfo *Revolve 1

|1se|eded

T~

[T

Rounds
4. Select the top and bottom edges and add a R.6 660

_‘% g Select an edge or chain of edges, or a surface to create round set.

Is/fillets.
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EXERCISE 4

Secondary Feature Modeling

1. sketch the geometry as shown below
Then Trim.

8. Revolve.
[ PRTO0006 (Active) - Pro/ENGINEER Student Edition (for educational use only) [olf[@]==
File Edit View Insert Analysis Info Applications Tools Window Help
S @y BEREew MERFFgRQAQGEsREh e o oD
e e el

:,éb

z;JQj 1Curve v w0 v~ X 7 [

Placement Options  Properties

Plelmlag

[Show~ ][ setings ]

(7J PRT0006.PRT

£7 RIGHT
£7TOP @ @.
£7 FRONT R@ % i

l‘j{x PRT_CSYS_DEF

7% Sketch 1

& Insert Here
(o> *Revolve 1

1 selected Al




8. Constraints: Select the Front datum plane and sketch the following. Use the
Constraint tool and select the Tangent option. Then select the left most horizontal line and the
arc attached to it to establish a tangent relationship.

9. Sweeps: left side of the curve we just created to create a new sketch datum at the
end.
10. Also select: (JSelectTraj/Curve Chain/Select All/Done/Donel]

& Select an edge from chain, pick 'Done’ when finished.
* Model will be displayed in wireframe display.

&> Select a curve from chain.

&> Select chain option from the menu.

& [@ |8

ga

(73 PRT0006.PRT
£7F RIGHT
£7 TOP
£7 FRONT
24« PRT_CSYS_DEF
Sketch 1
-k Revolve 1
7% Sketch 2
& Insert Here
" *Protrusion id 126

3 PROTRUSIOM: Sweep  [m5am|

Element Infa
Trajectory Selected Trajec
Attributes Free Ends

> Section Defining

] 1 3

Elefine | [ Refs | [ info |

ok ) [Canes) [rrover
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8.Draw the following sketch

8

“SelectAxisl] also select the Cview axis(]

Pattern Circular Pattern: 360°/3 = 120° (NOTE: First select the spoke to activate the icon.)

() PRT0006 (Active) - Pro/ENGINEER Student Edition (for educational use only)

[=EEs
File Edit View Insert Analysis Info Applications Tools Window Help
D E AT R e ~RAREFRQAQGFesh e o o)
s TN ,

S

4
‘ 1 Ttemig . 3‘ 1'250
Dimensions  Table Dimensions P.aferen& Tables
B &[4

Options

(7] PRT0006.PRT
£7 RIGHT
7 TOP
47 FRONT
9{: PRT_CSYS_DEF
Sketch 1
[ -cfo Revolvel
74 Sketch 2
% Insert Here
[ (2] *Pattern 1 of Protrusion

Properties

/“/ / =
o hY

\J< . / 3
\\\\ - e | 7
“7” 1 selected (s =

v /4 (36000

..... 3

7

/

7
Vad &
x"x v (]
2 b
X e
G bl
&l
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14. Fillet all edges

Gl
o
(3 PRT0006.PRT %
47 RIGHT Vo’ lf/?
L7 TOP
-4 F FRONT Q 4
3{-: PRT_CSYS_DEF Al
S &
g‘ Protrusion id 126 e A R @
& Insert Here !
) ¥Round 1

T

t
pe

| File Edit View Inset Analysis Info Applications Tools Window Help |
B - = <

D B & G Qoo By ([ 2 1)+
7 A

FINISH

(] PRT0006.PRT

47 RIGHT

{7 TOP

-£F FRONT

- 2%x PRT_CSYS_DEF

/. Sketch 1

[ o> Revolve 1

7% Sketch 2

() Pattern 1 of Protrusion
- o Insert Here

LB

X
-

S B




15. Rebuild after completion.

(3 PRTO0006 (Active) - Pro/ENGINEER Student Edition (for educational use only) =[5
File Edit View Insert Sketch Analysis Info Agpllcatlons Tools Window Help
: RE T
D& CEFgea@stgkh oo oD

- %% @F - .
* When constraint is displayed: Right click to disable it. Press Shift + right click to lock it. Use Tab key to toggle active constraint.

o> Select two entities or vertices to align.
o Select two entities or vertices to align.

w2 U

4

() PRT0006.PRT
£7 RIGHT
£7 TOP
£7 FRONT
3{: PRT_CSYS_DEF
Sketch 1

Pattern 1 of Protrusion
“¢ Round 1
& Insert Here

FINISH

16. REVOLVE

1>

Placement Options Properties

BREE] !

7
() PRT0006.PRT i
7 RIGHT &4
7 TOP .
£7 FRONT xs
. PRT_CSYS_DEF ¥
Sketch 1 .

l} Insert Here
[#-ofo *Revolve 2
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15. Add Rounds to the spoke — handle sections.

Bie St Yo et vyis e Agpcstons Took Wndow i
DB E &G G oy B B R W
g ARKTN

\‘ %

s FINISH

‘ Sets Transtions Pieces Options Propetties

(e swmwr)

(] PRT0006.PRT
47 RIGHT

-7 TOP

47 FRONT

-2« PRT_CSYS_DEF
-/ Sketch1

% Sketch 2
-] Pattern 1 of Protrusion ...

/7 Sketch 3
I:J--G;h Revolve 2

FINISHED
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